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OnSSET/Plataforma 

Global de 

Eletrificação 
Aula prática 2: Trabalhando com dados vetoriais1 

 

1) Siga a instrução "Instruções de instalação do QGIS 3.10" se ainda não tiver instalado 

o QGIS em seu computador. 

Resultados da aprendizagem 

Ao final deste exercício, você será capaz de:  

1) Importar dados vetoriais para o QGIS 

2) Executar diferentes processos-chave (como projetar, recortar) com dados vetoriais  

3) Georreferenciar uma imagem  

 

1 Este hands-on é um exercício desenvolvido por Khavari, B., 2019 Exercício 2: Trabalhando 

com dados vetoriais [Documento WWW]. Kit de Ensino OnSSET. URL 

https://onsset.github.io/teaching_kit/courses/module_1/Excercise%202/ (acessado em 

2.18.21). 

Todas as imagens são capturas de tela do QGIS 3.10, que está licenciado sob o Attribution-

ShareAlike 3.0 Unported (CC BY-SA 3.0). 

 

https://drive.google.com/file/d/1ss97yUm_vpLBNK12WwyRoOyA4t1LA_t7/view?usp=sharing
https://onsset.github.io/teaching_kit/courses/module_1/Excercise%202/
https://qgis.org/downloads/
https://creativecommons.org/licenses/by-sa/3.0/
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Aquisição de dados 

Faça download da pasta chamada "Benin_vector", disponível aqui, e salve-a na área 

de trabalho. Descompacte e abra essa pasta, na qual há várias pastas e arquivos 

adicionais. Para este exercício, certifique-se de que os seguintes arquivos/pastas 

estejam incluídos: 

• Uma imagem chamada "Benin_transmission_lines". 

• Uma pasta chamada "Transmission_Lines". Dentro dessa pasta, deve haver 

arquivos denominados "transmission_lines". 

• Uma pasta chamada "Administrative_Boundaries". Dentro dessa pasta, deve 

haver arquivos denominados "Administrative_Boundaries". 

• Uma pasta denominada "Administrative_Boundaries_Points" contendo os 

limites administrativos do Benin em formato de pontos denominados 

"Administrative_Boundaries_Points". 

Observação! É uma boa prática usar o sublinhado (_) ao nomear pastas ou conjuntos de 

dados no GIS (em vez de espaço) para evitar erros inesperados durante o processamento.  

Trabalho com dados vetoriais 

Abra o QGIS Desktop 3.10.X com o GRASS 7.6.X. 

OBSERVAÇÃO: um extenso tutorial do QGIS está disponível aqui.  

Importação 

1. A importação de vetores pode ser feita de duas maneiras diferentes: basta arrastar 

o arquivo vetorial para a tela do mapa ou acessar o menu suspenso superior e clicar 

em Layer → Add Layer → Add Vector Layer... 

1. Importe a camada "Administrative_Boundaries.shp" e a camada 

"transmission_lines.shp" que você recebeu (ao usar camadas vetoriais, 

procuramos os arquivos com extensão  .shp).   

Propriedades do vetor  

Em seguida, examinaremos as propriedades de diferentes arquivos vetoriais. Ao clicar com 

o botão direito do mouse em uma das camadas, você poderá examinar e/ou alterar as 

propriedades dos seus arquivos vetoriais.  

https://drive.google.com/file/d/1dtCO59PEfz4bWcFXk5VP7X6jAZhAQGZ9/view?usp=sharing
https://docs.qgis.org/3.10/en/docs/user_manual/index.html
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• Primeiro, clique na guia Information (Informações). Aqui você encontrará 

informações sobre sua camada.  
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• A guia mais importante para a aparência visual do seu conjunto de dados é a 

guia Symbology (Simbologia). Aqui você pode alterar muitos aspectos diferentes 

do conjunto de dados. Você pode alterar a cor, o estilo e o tamanho dos vetores.  
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• Em seguida, passaremos para a guia denominada Source Fields (Campos de 

origem). Aqui você poderá examinar os campos em seus dados com mais 

profundidade, o que pode ajudá-lo a identificar o tipo de dados e suas propriedades 

existentes em seu conjunto de dados. Isso pode ser muito útil quando você usa um 

conjunto de dados criado por outra pessoa. Se a edição estiver ativada, você 

também poderá adicionar/excluir colunas nessa guia. 
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Recorte de camadas de vetores 

Em muitos casos, o conjunto de dados que você está usando abrange uma área maior do 

que a sua área de estudo. Nessas áreas, pode ser útil delimitar o conjunto de dados para 

que ele fique restrito à área com a qual você está trabalhando. Para todos os tipos de 

arquivos vetoriais, usaremos a ferramenta Clip. Usaremos essa ferramenta para garantir 

que as linhas de transmissão com as quais trabalharemos estejam restritas às fronteiras 

de Benin. 

1. Torne a barra de ferramentas visível acessando o menu na parte superior da tela e 

clicando em Processing  → Toolbox.  
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2. Isso abrirá a caixa de ferramentas no lado direito da interface do QGIS. Nessa caixa 

de ferramentas, você pode procurar todas as ferramentas de que precisa. 

 
3. Agora, pesquise "clip", o que mostrará todas as ferramentas que incluem a palavra 

clip. 
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4. Neste exercício, escolheremos a ferramenta de clipe no pacote QGIS (a destacada 

na imagem acima). 

5. Na janela que se abre, escolha o conjunto de dados que deseja recortar no campo 

"Input layer" (Camada de entrada) e, no campo "Clip layer" (Camada de recorte), 

escolha o conjunto de dados que deseja recortar. Como camada de entrada, 

escolha transmission_lines e, como camada de recorte, escolha 

administrative_boundaries para recortar o vetor de linha de transmissão que você 

recebeu pelo polígono de limite administrativo.  
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Exportação 

Agora é hora de exportar as linhas de transmissão recortadas para a pasta apropriada. 

Essa é uma etapa muito importante. Quando você usa uma ferramenta no QGIS, por 

exemplo, "Clip", o arquivo de saída será salvo como um arquivo temporário se você não 

declarar explicitamente que deseja salvá-lo no computador. Isso significa que, na próxima 

vez que você abrir o QGIS, suas camadas serão perdidas, mesmo que você salve o projeto. 

Para evitar isso, você pode exportar suas camadas.  

1. Clique com o botão direito do mouse na camada recortada e clique em Exportar 

→ Salvar recursos como... 
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2. Escolha exportar seus arquivos vetoriais como shapefiles da ESRI. Clique nos três 

pontos ao lado do nome do arquivo e navegue até a pasta em que deseja salvar a 

camada (veja a imagem abaixo).  
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3. Nomeie sua camada como "transmission_lines_Benin" e navegue até a pasta 

chamada Transmission_Lines que você recebeu. Clique em "OK" (certifique-se de 

que a opção "Add saved file to map" (Adicionar arquivo salvo ao mapa) esteja 

marcada). Agora você pode remover o arquivo temporário chamado "Clipped", 

clicando com o botão direito do mouse e selecionando Remove Layer (Remover 

camada).  

 

Projeção de vetores  

O sistema de coordenadas é muito importante na representação de dados. Ao projetar 

uma área em um mapa, sempre haverá uma certa distorção. Ao escolher o sistema de 

coordenadas, é importante fazer concessões e escolher o sistema que ofereça a menor 

distorção. Para este exercício, como estamos trabalhando com o Benin, teremos de 
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escolher um sistema de coordenadas que funcione bem para o país. Nesse caso, estamos 

escolhendo um sistema de coordenadas chamado "WGS 84/UTM zone 31N" 

Reprojetaremos as linhas de transmissão que cortamos e exportamos. 

1. Na caixa de ferramentas, procure "Reprojetar camada" e clique duas vezes nela 

para usar a ferramenta. 

 

 

 

 

 

 

 
2. Primeiro, escolha o conjunto de dados que você deseja projetar (as linhas de 

transmissão recortadas) 

 

OBSERVAÇÃO: Ao selecionar o conjunto de dados, você poderá ver o sistema de 

coordenadas atual entre colchetes (veja a imagem abaixo). 
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3. Em seguida, clique no ícone ao lado do campo que solicita o CRS de destino e 

escolha o sistema de coordenadas de destino.  



 
 

CCG 2021                                                                                                                                      Página 14 

 

Isso abrirá a seguinte janela 
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No campo de filtro, comece a digitar o nome do sistema de coordenadas que deseja usar 

(zona UTM 31N). 

 

 

 

OBSERVAÇÃO: A unidade está em metros (+unidades=m) e a caixa vermelha no mapa, no 

canto inferior direito, cobre Benin.  
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4. Clique em OK e em Executar em segundo plano para executar a ferramenta. 

Quando terminar, exporte como "transmission_lines_Benin_reprojected" para a 

pasta "Transmission_Lines". 

OBSERVAÇÃO: para estudos futuros, o site https://epsg.io/ a seguir pode ser usado para 

determinar qual sistema de coordenadas você deve usar. Nessa página da Web, basta 

pesquisar o nome da sua área de estudo e escolher o sistema de coordenadas mais 

adequado ao seu estudo. 

  

https://epsg.io/
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Georreferenciamento 

Nesta parte, primeiro faremos a georreferência de um mapa de Benin e o usaremos para 

concluir as linhas de transmissão ausentes. Em muitos casos, você encontrará dados GIS 

desatualizados ou incompletos, e essa é uma maneira útil de gerar dados corretos quando 

esses casos ocorrerem. 

Georreferenciamento 

Como ativar o georreferenciamento 

O georreferenciamento pode ser uma ferramenta poderosa na identificação de 

determinados conjuntos de dados, como estradas, linhas de transmissão ou locais de 

subestações. Se esses pontos de dados não estiverem disponíveis como conjuntos de 

dados geoespaciais, eles poderão ser importados como uma imagem e, em seguida, 

ajustados à área de estudo. 

1. Primeiro, talvez você precise ativar o georreferenciamento. Em muitos casos, o 

georreferenciamento é desativado quando você instala o QGIS. Para fazer isso, 

acesse Plugins → manage and install plugins...   na parte superior da tela.   

 
2. Na janela que se abre, comece a digitar "georeferencer" e selecione "georeferencer 

GDAL" quando ele aparecer, marcando a caixa ao lado dele.  

 
3. Agora, se você voltar à tela principal e abrir o menu Raster, deverá ter a opção de 

fazer o georreferenciamento. 
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Como fazer a  

1. Primeiro, abra o Georeferencer. Na parte superior da tela, clique em File → Open 

Raster.  

 
2. Em seguida, navegue até a imagem chamada "Benin_transmissionlines.jpg" na pasta 

Benin que você baixou. Se você for solicitado a escolher um sistema de 

coordenadas, escolha WGS 84 (EPSG:4326).  
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3. Agora você poderá adicionar alguns pontos de controle ao seu mapa. Esses pontos 

de controle serão usados para alinhar a imagem com o restante dos conjuntos de 

dados. Use a roda do mouse ou os ícones na parte superior para aumentar e 

diminuir o zoom da imagem. Depois de aplicar o zoom que desejar, clique no mapa 

para adicionar um ponto de controle. Isso abrirá a janela abaixo. 
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Aqui, você pode optar por inserir os pontos de controle usando diretamente a tela do 

mapa, usando a opção "From map canvas" (Da tela do mapa), bastando clicar no ponto 

correspondente na tela. Quanto mais pontos, melhor. A ideia é ajustar as áreas conhecidas 

da sua imagem às áreas conhecidas dos limites administrativos que você importou. 

OBSERVAÇÃO: em vez do que foi descrito acima, você pode adicionar as coordenadas do 

ponto em que clicou diretamente nos campos X e Y. Essas coordenadas devem ser 

inseridas no sistema de coordenadas escolhido. Essas coordenadas devem ser inseridas no 

sistema de coordenadas escolhido 

   

4. Ao adicionar pontos, você verá que há linhas sendo adicionadas à janela 

denominada "GCP table" (Tabela GCP). Cada linha representa um ponto de controle 

que você adicionou. Quanto mais pontos, melhor, e você deve se certificar de que 

os pontos estejam cobrindo toda a área de estudo. Para este exercício, adicione 

entre 6 e 8 pontos (em geral, o número de pontos deve aumentar à medida que o 

tamanho da área de estudo aumenta).    
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5. Depois de inserir todos os pontos de controle, clique em Configurações 

→ Configurações de transformação... 
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Defina o tipo de transformação como Thin Plate Spline.  

Selecione o sistema de coordenadas correto no Target SRS (WGS 84). 

No campo Output raster (Rasterização de saída), localize a pasta que deseja usar para 

salvar a rasterização (escolha a pasta "Benin_vector" fornecida a você). 

Em Set Target Resolution, defina o tamanho de cada célula. Quanto menor o tamanho da 

célula, melhor (defina 0,0083 com sinal de menos, como na figura acima). Isso está em 

graus e corresponde a aproximadamente 1 km). OBSERVAÇÃO: para alterar a resolução 

do padrão, é necessário marcar a caixa "Set target resolution" (Definir resolução de 

destino); se for necessário alterar o sistema de coordenadas manualmente, 

desmarque a caixa antes da próxima etapa. O fato de a caixa estar marcada pode 

causar erros. 
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Marque a caixa "Load in QGIS when done" (Carregar no QGIS quando terminar). 

Quando isso for feito, clique em "OK" para fechar a janela. 

6. Por fim, vá para File (Arquivo) e clique em Start Georeferencing (Iniciar 

georreferenciamento). 

 

Isso pode levar algum tempo. Quando estiver pronto, o mapa deverá estar no mesmo local 

que os limites administrativos.  
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(O mapa acima foi criado colocando-se os limites administrativos em cima da imagem 

georreferenciada e transformando sua transparência em 50%. Você pode aumentar a 

transparência para 50% na primeira janela da guia de simbologia nas propriedades. Essa é 

uma boa prática se você quiser ter certeza de que o conjunto de dados está no local certo 

e para as etapas seguintes) 

7. Feche a janela de georreferenciamento e clique em "Save" (Salvar). 

OBSERVAÇÃO: se o seu mapa estiver completamente errado, isso pode ser devido a 

discrepâncias nos sistemas de coordenadas.  

Editar arquivos vetoriais: 

Às vezes, é interessante adicionar pontos/linhas/polígonos a um conjunto de dados 

existente ou criar um novo conjunto de dados vetoriais do zero. Aqui, examinaremos a 

primeira opção. 

1. Mova o conjunto de dados das linhas de transmissão reprojetadas para a parte 

superior do painel Layers (Camadas). 

2. Na guia Symbology (Simbologia) (em Properties (Propriedades)), torne as linhas 

pretas e aumente a Width (Largura) para que as linhas fiquem claramente visíveis. 

3. Clique com o botão direito do mouse no conjunto de dados e clique em "Toggle 

Editing" (Alternar edição). 

 
4. Isso habilitará algumas opções diferentes, dependendo do tipo de arquivo vetorial 

com o qual estiver trabalhando (se estiver trabalhando com pontos, poderá 
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adicionar pontos; se estiver trabalhando com linhas, poderá desenhar linhas; se 

estiver trabalhando com polígonos, terá a chance de desenhar polígonos). 

 
5. Agora você pode simplesmente clicar/desenhar o cursor onde quiser adicionar 

dados, clicando na linha em forma de V na caixa vermelha acima (marcada na 

imagem acima). Depois de clicar nessa linha, você poderá desenhar suas linhas 

clicando no mapa. O primeiro clique definirá seu ponto de partida e, depois disso, 

você poderá adicionar quantos pontos quiser.  

 

Quando terminar uma linha, clique com o botão direito do mouse no último ponto. Isso 

abrirá a tela a seguir: 

 

Aqui você atribui dados. Neste exercício, digitaremos apenas um número e, por enquanto, 

não importa o número que você escrever, pois essa é apenas uma forma de distinguir 

entre diferentes segmentos de linha.  

Use o editor e o mapa georreferenciado para preencher as linhas de transmissão ausentes 

(somente as linhas existentes, de acordo com a legenda na parte inferior (linhas verdes) do 

mapa georreferenciado) na camada de linha de transmissão reprojetada que você criou  

6. Clique em Save Layer Edits (Salvar edições de camada) e, em seguida, desative 

Toggle Editing (Alternar edição). 
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OBSERVAÇÃO: a precisão das linhas e dos pontos depende da escala em que foram 

criados; se você aumentar o zoom depois de desenhar as linhas, verá discrepâncias. Uma 

delas pode ser o fato de as linhas não se conectarem umas às outras. Para corrigir isso, vá 

para Project (Projeto) → snapping options (Opções de encaixe). 

 

Aqui você define as variáveis conforme mostrado abaixo. 

 

 

Agora, quando você estiver perto o suficiente de uma linha, o QGIS se certificará de que a 

nova linha esteja conectada à antiga. 

7. Salve as edições. 
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Determinação da distância 

Nesta parte, determinaremos a distância até as linhas de transmissão. Ao planejar um 

sistema de energia, é fundamental conhecer as distâncias de diferentes infraestruturas 

para poder tomar decisões informadas.  

Criação de mapas de distância 

Ao calcular distâncias no QGIS, precisamos usar duas camadas de pontos. Isso significa 

que não podemos simplesmente determinar a distância das linhas de transmissão 

modificadas sem antes convertê-la em pontos.  

Converta as linhas de transmissão em pontos: 

1. Para converter as linhas de transmissão em pontos, usaremos uma ferramenta 

chamada "convert lines to points" (converter linhas em pontos) do pacote SAG A. 

 
2. Ao clicar na ferramenta, a janela a seguir será aberta. 
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Para as linhas, escolha as linhas de transmissão que você editou no final da Parte 2.  

A distância inserida determinará a distância entre os pontos. Essa distância estará na 

mesma unidade em que está o sistema de coordenadas. Como projetamos as linhas de 

transmissão em um sistema de coordenadas que usa metros, essa distância está em 

metros. Insira 100 para criar pontos espaçados com 100 metros de distância entre eles.  
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Crie um mapa de distâncias: 

1. Importe a camada administrative_boundaries_points de Benin e reprojete-a usando 

a camada Reproject em "WGS 84/UTM zone 31N", conforme feito anteriormente 

neste exercício. Isso é feito porque é importante que o mapa esteja em um sistema 

de coordenadas que utilize unidades lineares, caso contrário, as distâncias podem 

ficar distorcidas. Além disso, se os sistemas de coordenadas forem diferentes entre 

dois mapas usados para determinar as distâncias, as distâncias estarão erradas.  

2. Para criar um mapa de distância, usamos a ferramenta QGIS Distance to nearest 

hub (points). Procure por ela na Caixa de ferramentas de processamento. 

 
3. Você verá a tela a seguir: 
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Como Source point layer (Camada de ponto de origem), coloque a camada para a qual 

deseja determinar a distância, neste caso o arquivo de pontos do país: 

administrative_boundaries_points (pontos de fronteiras administrativas). 

Como camada do hub de destino, coloque a camada da qual você deseja determinar a 

distância. Nesse caso, essa é a camada de pontos que geramos anteriormente a partir das 

linhas de transmissão: transmission_lines_Benin_reprojected. 

OBSERVAÇÃO: As camadas devem ter o mesmo sistema de coordenadas. 

Para Unidade de medida, você pode escolher entre alguns tipos diferentes de unidades 

de comprimento. Nesse caso, escolha Metros.  

4. Agora, execute a ferramenta. O resultado será uma camada de pontos com a 

mesma cor em todo o país. No entanto, isso pode ser alterado na guia Style (Estilo) 

em Symbology (Simbologia). Altere o estilo para que o mapa seja exibido como 
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abaixo. Isso pode ser feito clicando na guia Simbologia em Propriedades, definindo 

o estilo como graduado e escolhendo exibir a coluna de distância.  

 

 

 

OBSERVAÇÃO: Exporte o mapa de distância, pois ele também será usado no exercício de 

rasterização. Salve o mapa de distância com o nome "transmission_lines_distance" na 

pasta "Benin_vector".  


